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Principle
The comet assay, also known as single-cell gel electrophoresis (SCGE), has become an attractive assay in
the assessment of DNA damage. Its simplicity, sensitivity, speed and economy make it a prime choice in
genotoxicity testing, ecogenotoxicity, human epidemiology studies as well as mechanistic studies of DNA
damage and repair. Although this assay is described as a method for DNA damage quantification, the
SCGE has evolved to now provide information about all kinds of DNA lesions to be detected. The comet
assay was first described by Ostling and Johanson as a method of DNA strand break analysis. Cells with
increased DNA damage display increased migration of DNA from the nucleus toward the anode. While
this method was groundbreaking, its protocol was modified through the years to improve sensitivity and
reproducibility. Singh et. Al. explain that the neutral conditions for lysis and electrophoresis only permit
the detection of double-stranded DNA breaks, and do not allow for the detection of single-stranded ones.
They also emphasize that most of the DNA damaging agents induce 5- to 2000-fold more single-stranded
than double-stranded breaks. For these reasons, they have developed a new comet assay protocol, which
allow alkaline conditions to reveal single-strand breaks and to degrade cellular RNA that interfere in the
quantification of the stained samples (3). Although single-strand breaks occur more frequently, Olive et.
Al. highlight the fact that double-strand breaks are considered to be of greater biological consequence
since they can lead to chromosome aberration and loss of genetic material.

Comet Assay Protocol
Day 1
1.
2.
3.

	
  

(Cell plating and buffer preparation)
Plate 200 000 cells per well – 1ml total volume (2 wells per treatment)
Allow cells to attach overnight
Prepare the following buffers:
Lysis buffer A (fresh, 1-3 days maximum, 44.5 mL per film with 6 “wells”)
146.1 g NaCl
41.6 g Tetra-Sodium EDTA
1.2 g Tris base
10.0 g N-Lauryl Sarcosine
dH2O
1L
- adjust to pH 10
Lysis buffer B (50 mL per film with 6 “wells”)
146.0 g NaCl
41.6 g Tetra-Sodium EDTA
1.2 g Tris base
dH2O
1L
- adjust to pH 10
Neutralization buffer (stored at +40C) (4 mL per film with 6 “wells”)
77 g Ammonium acetate
dH2O
100 mL
Agarose (in an Erlenmeyer flask)
0.75 g LMP (low melting point, DNA grade) agarose
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100 mL PBS
- heat until boiling and translucent
- cover and place at 4 °C
Day 2 (treat cells and gel preparation)
1. Adding drugs:
• Dilute drugs (make 45 min-1 hr time interval between sets of treatments). Concentrations (6):
100, 20, 25, 12.5, 6.25 uM, DMSO control.
• Aspirate media, add 1mL drug dilution per well
• Incubate mixture for a specific amount of time (2 or 24 hrs)
2. While the drug is incubating, prepare the gel:
• Melt the agarose in an Erlenmeyer flask on a hot platform with stir. Leave it on the minimum
heating with stir for the entire period of use.
• Cut the Gelbond film (in a dark room!) to fit the electrophoresis apparatus (1 film per 6-well
plate, make specific cut of the top right corner for each set of treatment). Put with paper on foil
sheet with hydrophilic side facing up.
• Use some agarose to help attach the chambers to the Gelbond film (in a dark room!). Pour
some agarose into a big dish, dip the chamber (wider base down) into agarose, press the chamber
onto the hydrophilic side of the film. Repeat 3 times/film -> making 6 “wells”. Don’t touch
agarose with fingers while holding the chamber. Chambers don’t need to be washed afterwards.
• Allow the agarose to cool slightly (5-10 min). Make sure there is a separation between 6
“wells” on the film.
3. Transferring cells into the gel
• Terminate treatment by removing media and rinsing with PBS (1mL) – start with control and
go from lowest dose till the highest.
• Collect cells through trypsinization (0.5mL of trypsin, wait, add 1mL media (10% FBS)).
Transfer cells to labelled 15 mL tubes (collect duplicates into the same 15 mL tube).
• Pellet cells by centrifugation (1.6 rpm for 5 minutes, 4oC)
• Aspirate media. Resuspend pellets in 1 mL PBS. Centrifuge (1.6 rpm for 5min, 4oC)
• Resuspend cells in 1 mL PBS (or in 500ul, if not many cells), put tubes on ice.
• Turn off the lights in the room. Prepare 3 pipettes (30, 150 and 270 ul), tips and eppendorfs
(non-sterile).
• Vortex gently or pipette up and down cell suspension, transfer 30µl into a labelled 1.5 mL
eppendorf tube.
• Add 270µl of agarose, maximum temperature 37oC (use a thermometer or touch the hand).
• Take 150 ul pipette, pipette up and down, put 150µl in one of the 6 “wells” on the film
(distribute evenly without touching the borders of the “well” with a tip, get rid of bubbles).
• Repeat for all samples
100 uM
50 uM
25 uM
12.5 uM
6.25 uM
DMSO
• Put the film (without a paper) with gels into the Petri dish, wrap in foil (protect from light) and
leave for about 5 min for polymerization.
4. While the gel is polymerizing, make the lysis buffer in a 50ml tube (1 tube per film). Shake with
hand.
- 44.5 mL of lysis A
- 5 mL DMSO
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- 0.5 mL Triton X-100
20. Pour lysis buffer into large Petri dish (not directly on top of film but around it) with the film
(make sure it is submerged).
21. Wrap the Petri dish in foil and place it at 4 °C overnight
22. Return extra agarose to 4 °C.
Day 3 (Unwinding buffer preparation, lysis B transfer, electrophoresis)
1. Discard lysis A buffer into the sink.
2. Wash the gel in the dish with mQ dH2O (3 times)
3. Pour 50 mL of lysis B into the dish (around the film), wrap in foil and incubate for 60 min. at 37
°C (place the foil sheet on the shelf of incubator to prevent leakage).
4. After 30 min, repeat steps #1-3 for the 2nd film, in another 30 min – the 3rd.
5. Meanwhile, prepare Unwinding/electrophoresis buffer (~320 mL/ film, keep bottle covered with
aluminium foil). For 1 L:
- 12.0 g NaOH
- 4.2 g Tetra-Sodium EDTA
- 1.0 g 8-hydroxyquinoline
Add 700 mL dH2O
Add 20 mL DMSO
- mix using the magnetic stir bar
Add 280 mL dH2O
- check pH (adjust to pH 13, if necessary)
6. Discard lysis B buffer into the sink
7. Wash in distilled water (3 times)
8. Place the gel in the unwinding buffer (~50 mL)
9. Cover in foil and store at room temperature for 30 minutes
10. Collect the unwinding buffer into the organic waste bottle.
11. Set up the electrophoresis apparatus
20V
400mA
20 min.
12. Pour 270 mL of the unwinding buffer into the electrophoresis apparatus
13. Place the film in the electrophoresis apparatus with the top side (that has a specific cut) facing the
black (-) electrode.
14. Press run (If the voltage is 19V, run for 25 minutes instead). Cover with a box to protect from
light.
15. Dilute the neutralizing buffer (10M Ammonium acetate) (for 1 film: mix 4 mL buffer and 40 mL
dH2O)
16. Place the gel in the neutralizing buffer for 30 minutes at RT.
17. Collect the unwinding buffer into the organic waste bottle. Use fresh buffer for each run.
18. Discard the neutralizing buffer into the sink, place the film in 100% ethanol for 2 hours.
19. Let the gel dry overnight (put the dishes in the box, put the films on the edge of the dish so that
the surface underneath the film gets fry). Cover with foil.

Day 4 (staining)
1. In a dark room dilute the 10 000X SYBR gold to 1X in ddH2O (per film: 40 mL H2O + 4 ul of
dye)
2. Pour the dilution of the dye directly on the top of the film.
3. Stain for 10 to 15 minutes in darkness.
	
  

3	
  

Molecular	
  and	
  Clinical	
  Radiobiology	
  Workshop	
  	
  	
  	
  Lab	
  Practical	
  Tutorial	
  Sessions	
  RI-‐MUHC	
  	
  June	
  19th,	
  2015	
  

	
  
4. Discard the dye into the sink.
5. Let the film dry ON in the room or 2-4 hrs under the fume hood in the darkness.
6. Can store at +40C in darkness (up to 2 weeks).
Day 5 (acquiring images)
1. Turn on microscope power 15 min in advance. Password – “password”.
2. LAS -> exposure 1.5s (can increase to 2s); Saturation – 0; Gamma – 1.69 (background); Gain –
4.8x, Input option – greyscale.
3. Turn on shutter – fluorescence ON. Filter – HQF
3. Acquire image. Options->Preferences-> Select the folder where to save.
4. Check Autosave option.
5. Format – bitmap. Take at least 50 pics per concentration. The undamaged nucleus has to be to the
left and the tail – to the right from it.
Analysis
1. Comet assay IV. Image bank->Load image->choose image.
2. Click on nucleus. Blue line – beginning of nucleus, green – middle of nucleus; pink – end of tail.
For manual adjustment click Edit. Numbers in table – tail moment.
3. Analyze all images for one concentration. Then click File->Save as-> Excel
4. Erase all the results in the software. Move to next concentration.
In Prism
1. n=50 (tail moment). Concentration (X axis)
2. Analyze -> Row means (average)
3. Transform-> K different for each treatment (100)

Potential applications
Applications: in vitro, in vivo and clinical use
One of the primary uses of the comet assay is in genotoxicity testing. It is provides a set of information
about safety and toxicology on newly developed pharmaceuticals and chemicals. Since some drugs are
prodrugs and therefore become active only after hepatic metabolism, metabolites can be assessed for their
genotoxicity potential. The comet assay is not only useful in the assessment of chemical toxicities but it
can also allow the study of the protective effect that some phytochemicals have on genes when exposed to
some genotoxic insults. Since dietary factors have been estimated to contribute up to 30-40% factor,
human nutrition effect on cancer development is an important element to consider. In these studies, the
comet assay is a simple cheap a rapid method to assess DNA damage and repair. Since human being as
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constantly exposed to the balancing effect on genotoxic agents present in the direct environment and
antioxidants, biomonitoring studies allow the monitoring of lifestyle and environmental carcinogenesis.
Furthermore, the alkaline comet assay can be used to assess the DNA damage in individuals
occupationally exposed to ionizinng radiation. All this biomonitoring can be done with very little invasive
test with blood samples, tissue swab or in a more invasive manner, a liver biopsy. Then a standard
alkaline comet assay can be performed and results acquired.

Comet assay variants
àAlkaline and neutral comet assays to discriminate between single- and double-strand break
The alkaline comet assay separates the two DNA strands around the break by alkaline denaturation to
reveal the alkaline-dependent single-strand break but also DSBs, and the neutral SCGE selectively detects
double-strand breaks by using a neutral lysis conditions, leaving the alkaline-dependent single-strand
breaks undetected.

àLesion-specific enzyme to detect the category of DNA damage
To discriminate between direct damage from the test chemical, intermediates in nucleotide- or baseexcision repair, and AP site, lesion-specific enzymes may be introduced. These enzymes target DNA at
sites that show a specific base alteration and only cause DNA-strand break at that site.

àBromodeosyuridine labeling to determine replicative integrity
During DNA replication, DNA is naturally forming fragment, which could be detected as DNA strand
breaks in comet assay. This assay does not discriminate between S-phase ‘’DNA fragments’’ and non-Sphase or strand-breaks. By introducing bromodeoxyuridine (BudR) as a label for replication, detection
with BudR antibody will make comet tails caused by DNA replication distinguishable. This technique can
also be used to determine carcinogenesis through replicative integrity.

àFluorescent in situ hybridization (FISH) in combination with comet assay
It is used to monitor the repair of particular genes. FISH is a technique used to localize specific DNA
sequences within the chromatin and chromosome and identify structural and numerical chromosome
changes (32) In the case of comet/FISH, oligonucleotide probes are used to target one strand of a specific
gene. These probe are labeled with fluorescent tags to allow the identification of this gene in the comet as
whether this DNA sequence is damaged or not
à Detection of cross-links
Since the cross-links keep the DNA covalently attached altogether, this would mean there would be a
slower electrophoretic migration of the DNA. This modified comet assay compares the migration of
irradiated DNA with a cross-linker versus irradiated non-cross-linked DNA control. It has been shown
that the extend of retardation in DNA migration is proportional to the level of interstrand cross-linking.
This method can also be used to measure the extent of DNA cross-links repair in patients treated with
chemotherapeutics causing these types of damage.
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Appendix - Reagents
Name

Full name

Volume

Producer

Catalogue #

For

NaCl

Sodium chloride

3 kg

Fisher

S271-3

A, B

Tetra-Sodium EDTA, 98%

Ethylenediaminetetraacetic
acid tetrasodium salt hydrate

500 g

Aldrich

E26290

A, B, E

1 kg

Fisher

BP152-1

A, B

500 g

Sigma

L5125

A

Tris base
N-Lauryl Sarcosine, ≥94.0 %

N-Lauroylsarcosine sodium
salt

Triton X-100
DMSO non-sterile

A
Dimethyl Sulfoxide

A, E

Ammonium acetate, 98%

500 g

Sigma

A1542

N

8-hydroxyquinoline, ≥99.0 %

100 g

Fisher

BP436-100

E

NaOH

Sodium Hydroxide (pellets)

500 g

ACP Chemicals

S3700

E

LMP agarose

Agarose DNA grade (low
melting) Electrophoresis grade

25 g

Fisher Biotech

BP165-25

gel

SYBR Gold Nucleic Acid Gel
Stain

10,000X Concentrate in
DMSO

500 ul

Life
technologies

S-11494

dye

Gelbond film, 102mm x
16.5M ROLL

Agarose support medium

Lonza Rockland

53740

film

A – lysis buffer A; B - lysis buffer B; N – neutralization buffer; E – unwinding/electrophoresis buffer.
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